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Org Chart Spreadsheet Maintenance Procedure 

I. Spreadsheet Maintenance Process 

A. Overview 

1. The following procedures cover the maintenance of the Org Chart section 
on the OCIO website. This procedure only covers updating the data of existing 
ORG pages. It does not cover the adding, deleting or modifying of ORG pages 
or page elements, such as the tabbed panels and graphic display. These tasks 
should be passed to development personnel. 

2. Description of Process.  

a) Using MS Excel and Org Chart Professional, ISD has developed a 
method of standardizing data handling and exporting of that data for 
display in OCIO organization charts on the appropriate pages of 
subordinate organizations within the “OCIO Org” section of the OCIO 
website.   

b) Through the use of eXtensible Markup Language (XML), the data 
needed to automate the organization information is contained in an 
Excel Spreadsheet.  

c) The production of the artwork is accomplished through Org Chart 
Professional, using the same spreadsheet used to export the data in the 
“Staff” section of the “Org_sub” section of the subordinate 
organizations of OCIO (See figure 1). 

 
Figure 1 
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B. Excel Spreadsheet Description 

1. Naming Conventions. The spreadsheet is named 
master_ocio_org_chart_vX.xls (the X represents the current version number of 
the spreadsheet). The Excel spreadsheet comprises six worksheets; 

a) Employees (Emp): Contains all org chart employee information 

b) Content Owners (CO): Contains subject matters content ownership 
information. 

c) Description (Desc): Contains organizational descriptive information. 

d) Graphics Info (GI): Contains org chart image information. 

e) Documentation (Doc): Contain documentation and notes related to 
the other worksheets. It is NOT part of the data process. 

f) Dummy Emp ID (DEI): Contains a listing of used pseudo employee ID 
numbers for use with “Vacant” positions. It is NOT part of the data 
process. 

g) Hereafter, the worksheets are referenced by their abbreviation as 
shown above. 

2.  General Spreadsheet Update Process 

a) Regardless of which worksheet requires updating, the following 
basic process occurs: 

(1) Open Dreamweaver (DW) and synchronize with the OCIO 
website. 

(2) Once synchronized, navigate in DW to 
_Content_Source_Files/OrgChart/2009_NewMethod. Note: Once 
the year changes to 2010, the _NewMethod designation will no 
longer be used on the directory name. It is used in 2009 to 
differentiate between the old and new org chart creation methods. 

(3) Create a new directory with the current date in this format: 
YYYYMMDD. If an edit of the Emp worksheet is required, create a 
subdirectory called flash. 

(4) Open the previously most recent dated directory and copy the 
master org chart spreadsheet contained therein to the newly 
created dated directory. 
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(5) Update the version number to the next increment in the file 
name, i.e. master_ocio_org_chart_vX.xls, the X represents the 
current version number of the spreadsheet 

(6) Post the file to the web server. 

(7) Depending on which worksheet requires updating, check out 
the respective XML files. The XML files are located in assets/data/. 

(a) Emp = ocio_org_chart_master_employees.xml 

(b) CO = ocio_org_chart_master_contentowners.xml 

(c) Desc = ocio_org_chart_master_desc.xml 

(d) GI = ocio_org_chart_master_graphics.xml 

NOTE: This step is needed so that later on the edits can be saved to the XML file. 

(8) Open and edit whichever worksheet that requires editing. 
(NOTE: For further detailed instructions, please see section C. 
Worksheet Editing.) 

(9) Once editing is finished, save the spreadsheet. (Do not close the 
file.) 

(10) Export the revised data. From the menu bar, select Data > 
XML > Export. Due to a bug in Excel, the Export XML map selection 
window may open. If it does, proceed to step 10.a. If it does not, 
proceed to Step 11. 

(11) Once the Export XML - Map Selection window opens, select 
the appropriate data map by highlighting the map name on the list 
and clicking OK (see list below). The maps are as follows: 

(a) Emp = OCIO Employees Map 

(b) CO = OCIO Content Owners Map 

(c) Desc = OCIO Org Description Map 

(d) GI = OCIO Org Chart Graphics Map 



 

4 

NOTE: If the export map is missing, please proceed to III. Troubleshooting: Attach a Data Map 
section. Once the issue is solved, return to Step 11. 

(12) The Export XML - File Selection window opens. Navigate to 
the local Dreamweaver OCIO site, then go to the assets/data/ 
directory. Once in the directory, a listing of stored XML files will 
show. Select the appropriate file based on the listing in step 7. Click 
the Export button. Excel will display a warning that the file will be 
overwritten and requests confirmation that this is the desired 
action. Click Yes. (REMINDER: These files were checked out in Step 7.) 

(13) Exit out of the Excel spreadsheet. 

NOTE: Spreadsheet was saved in Step 9. If additional changes were since step 9, resave the file 
again.) 

(14) Return to Dreamweaver, check-in the Excel spreadsheet in 
the 
_Content_Source_Files/OrgChart/2009_NewMethod/YYYYMMDD 
directory and the respective XML file(s) in assets/data/ directory. 

(15) Launch a browser and navigate to the OCIO website. View 
the modified ORG page(s) and check the page(s) to ensure that the 
updates occurred and everything looks OK. 

II. Producing the Artwork in Org Chart Pro 

A. Since most of the changes to the excel spreadsheet were completed in the above steps, 
the creation of the artwork is subordinate to the creation of the XML generated content. 
Org Chart Pro is much more adaptable then the process to create XML. To ensure 
consistency; the images are created using the following guidelines; 

1. General 

a) The background of the charts is considered the area behind the 
actual chart, the background color is HEX F2F2F2 for all charts with the 
exception of the OCIO main organization chart on the OCIO Org landing 
page, which is FFFFFF 

(1) Boxes 

(a) Fill color: E9AC13 

(b) For Shading Style, choose Diagonal Down:  
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(2) Shape: 

(a) For all employees except assistants and staff; 

 

(b) For staff and assistants; 
 

 

Note: To make the determination if a person falls within a “staff position” use the following 
litmus test; does a person, who does not have any direct reports, have people of equal rank 
reporting to a their supervisor?  For example; 

 

Consider Doug Salser, Diane Lewis, Donna Cooper and Christine Kitchens were all the same 
pay grade, Doug would be considered filling a staff position because he does not have any 
direct reports, whereas Diane, Donna and Christine directly report to Martha Sneed and have 
people reporting to them. 
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B. In Org Chart Pro, The information contained in the boxes correlate to columnar data in 
the spreadsheet; 

 

C. Box Layout; 

 

1. Main organization boxes: 

 

2. Assistants; 
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III. Producing the artwork 

A. There are three processes to produce the images,  

1. Synchronizing the data  

2. Producing the images 

3. Producing the Flash files  

B. Synchronizing data 

1. This process concerns “Resyncing” the data between the Excel Spreadsheet 
and Org Chart Pro. This only needs to be completed when there are changes in 
the spreadsheet. 

a) Open Dreamweaver, synchronize the “cio site”. 

b) Once synchronized, navigate to the location of the spreadsheet in 
Dreamweaver and check it out. 

c) Open Org Chart Pro,  in the File menu choose Open and navigate to 
S:\project_org_chart_staging\ocio.toc and open. 

d) On the menu bar, click Chart and choose Resync Properties.  

e) Click Browse and navigate to the location of the spreadsheet in step 
B.1.a) 

 

f) Choose the spreadsheet “Employees$” 
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g) This step builds the hierarchy of the chart, essentially, “who works 
for who”, Choose the option “Two columns” and in the Position box 
choose Combined and in the Reports to box choose Manager ID, then 
click Next: 

 

h) Ensure all Update Fields are checked, click Next 

 

i) Choose Update division name, in the item list click “Emp ORG 
Acronym” then click Division Naming. 
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j) Click Clear, then Click Add column then Select Emp ORG Acronym, 
Click Ok then Finish. 

 
 

C. Exporting the images 

1. On the File, choose Publish 
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2. Choose Image File 

 

3. Choose Current Chart to export the entire Chart, Active Sheet to Export the 
sheet o screen 

 
 

4. Navigate to “S:\project_org_chart_staging\images\” and create a folder 
with the present date as “YYYYMMDD”, click save. 
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5. Click Next to confirm destination 

 

6. Click Next to execute conversion 

 

7. Click Finish 
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IV. Exporting to Flash 

A. We also provide a Flash version of the OCIO Organization Charts. 

1. Rename the chart/Ensure the Chart is named “OCIO”. 

 

2. On the File menu, click Publish then Click Macromedia Flash 8 
 

 

3. Click Next. 
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B. Click Next. (These options are the default, they are chosen on import/sync) 

 

C.  Create a new folder in S:\project_org_chart_staging\flash, using this convention 
YYYYMMDD_flash, return to Org Chart Pro 

 

D. In the File Selection Dialog Box Click Browse, then navigate to the folder created in 
step 5, click OK.  

 

E.  Select “Show organization tree” and Index file name is lower case. 
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F. Click Yes 
 

 

G. Click Next to start the publishing wizard 

 

H. Click Finish, your default web browser will open the organization chart. 
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V. Getting the images to the Intranet Site 

A. The Images and Flash files are located in either S:\project_org_chart_staging\images 
or S:\project_org_chart_staging\flash in sub folders according to the date, getting the 
images to the production server requires and FTP program. The program used is WS-FTP, 
although any will suffice. 

B. FTP the images from S:\project_org_chart_staging\images\YYYYMMDD\file.jpg to 

1. cisd/cio/org/charts and  

2. /cisd/cio/_Content_Source_Files/OrgChart/2009_NewMethod\chart\YYYYT
MMDD 

C. FTP the all Flash Files from S:\project_org_chart_staging\flash\YYYYMMDD\ 

1. cisd/cio/org/charts 

2. /cisd/cio/_Content_Source_Files/OrgChart/2009_NewMethod\flash\0YYYY
TMMDD 

VI. Worksheet Editing 

A. Most editing is straight forward. The information below relates to what is expected on 
each data worksheet. 

1. Employees (Emp) 

a) The worksheet has thirteen columns: 

(1) Emp ID: Uses the five digit employee number as shown in 
ELF/PALM. OrgChart Pro uses this number to create relationships. 
Spry uses the number to finish the hyperlink to ELF/PALM. Required 
data type: Integer. 

(2) Relationship: Used by OrgChart Pro. This field has the following 
possible values: 0 means a null value, 1 means person is duplicated 
once for organizational purposes, 2 means a person is duplicated 
twice. Required data type: Integer. 

(3) Combined: Concatenation of fields 1 and 2. Used by OrgChart 
Pro. This field provides a unique identifier where a person appears 
multiple times within the organization structure. Required data 
type: Integer. 

(4) Emp First Name: The employee’s first name. Used by Spry and 
OrgChart Pro. Required data type: String (i.e. text). 
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(5) Emp Last Name: The employee’s last name. Used by Spry and 
OrgChart Pro. Required data type: String. 

(6) Emp Full Name: Content generated by Excel by concatenating 
fields 4 and 5. Only used by Spry if the value is ‘Vacant’. Used by 
OrgChart Pro. Required data type: String. 

(7) Emp Title: The employee’s position title. Used by both OrgChart 
Pro and Spry. Required data type: String. 

(8) Manager ID: Uses the five digit employee number as shown in 
ELF/PALM. Used by OrgChart Pro. Required data type: Integer. 

(9) Manager First Name: The manager’s first name. Used by 
OrgChart Pro. Required data type: String. 

(10) Manager Last Name: The manager’s last name. Used by 
OrgChart Pro. Required data type: String. 

(11) Manager Full Name: Content generated by Excel by 
concatenating fields 9 and 10. Used by OrgChart Pro as a reference. 
Required data type: String. 

(12) Parent Org: The organization that is the immediate parent 
of the employee’s organization. Used by Spry as the first part of a 
two part test to determine if the employee data should display on a 
particular page. Required data type: String. Additional requirement: 
Uppercase acronym. 

(13) Emp ORG Acronym: The employee’s organization. Used by 
Spry as the second part of the two part test to determine if the 
employee data should display on a particular page. Required data 
type: String. Additional requirement: Uppercase acronym. 

2. Content Owners (CO) 

a) The CO worksheet information displays on the organization’s web 
page in the first tab of the tabbed panel set. It shows the content for 
which a particular organization is responsible. The worksheet has four 
columns, which are as follows: 

(1) Primary Content Owner: The primary content owner is the 
first level parent immediately below the CIO, e.g. CISG, CSSG, and 
their like. Required data type: String. Additional requirement: 
Uppercase acronym.WARNING: Even if a primary content owner 
has not content, the acronym MUST appear in this listing ONCE. 
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All other fields remain blank.Content Owner: The actual owner of 
the content. Use the full path of the content owner’s 
organization. For example, something owned by Document 
Service Branch’s Monitoring Section would show as 
CISG/PRD/DSB/MS. Required data type: String. Additional 
requirement: Uppercase acronym. 

(2) Content Title: The name of the content subject matter, e.g. SDLC 
or UEA. Only main sections will be listed, as opposed to individual 
pages. Required data type: String. 

(3) Content URL: The absolute path to the HTML content subject 
matter main page (without the domain), e.g. SDLC’s URL is 
/ptointranet/cisd/cio/sdlc/sdlc.html. 

3. Description (Desc) 

a) The Desc worksheet contains the descriptive information for each 
organization. It also generated the organization’s full name. The 
worksheet has four columns, which are as follows: 

(1) Org Parent: The organization that is the immediate parent of 
the employee’s organization. Used by Spry as the first part of a two 
part test to determine if the employee data should display on a 
particular page. Required data type: String. Additional requirement: 
Uppercase acronym. 

(2) ORG Acronym: The employee’s organization. Used by Spry as the 
second part of the two part test to determine if the employee data 
should display on a particular page. Required data type: String. 
Additional requirement: Uppercase acronym. 

(3) ORG Name: The organizations full name. If the name contains 
an ampersand, the ampersand must be encoded (&amp;). Required 
data type: String. Format: HTML. 

(4) ORG Description: The organization’s full description. This 
content is HTML code; consequently, each paragraph must be 
wrapped in a paragraph tag, i.e. <p>paragraph text</p>. Both 
<strong> and <em> tags may also be entered. If the content 
contains a non-obvious acronym, the acronym should be wrapped 
in an acronym tag with a title attribute spelling out the acronym, i.e. 
<acronym title=”Spelt out acronym”>ACRONYM</acronym>. 
Required data type: String. Format: HTML. 
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4. Graphic Info (GI) 

a) The Graphics Info worksheet contains information displays each org 
chart. 

(1) ORG Parent: In all cases EXCEPT for the CIO front office (direct 
reports to the CIO), the field reads ‘OCIO’. If it is the CIO front 
office, i.e., ORG Acronym reads ‘CIO’, this field is USIP. Used by 
Spry as the first part of a two part test to determine which org 
chart should display on a particular page. Required data type: 
String. Additional requirement: Uppercase acronym. 

(2) ORG Acronym: The group level acronym, e.g. CISG, CSSG. 
Used by Spry as the second part of the two part test to 
determine which org chart should display on a particular page. 
This field also serves as the first part of the image file name; 
therefore, all images must have their org name in uppercase. 
Required data type: String. Additional requirement: Uppercase 
acronym. 

(3) Img Ext: The image type, e.g. jpg, gif, png. The default is jpg. 
Required data type: String. 

(4) Chart Width (px): The width of the image in pixels. Standard 
896px and maximum allowable width. Required data type: 
Integer. 

(5) Chart Height (px): The height of the image in pixels. This 
height will vary from organization to organization. Required data 
type: Integer. 

(6) Chart Alt: The text that should be displayed as the image 
alternate for accessibility. The acronym must have spaces between 
each letter. Required data type: String. 

5. Documentation (Doc) 

a) Doc provides documentation related to the spreadsheet and the 
task process. Documentation includes details on what Spry and 
OrgChart Pro use, Excel/XSD mappings, and the ELF URL. 

6. Dummy Emp ID (DEI) 

a) The DEI lists dummy Emp ID numbers for use with vacant positions. 
The OrgChart Pro software requires an Emp ID and Manager ID in order 
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to properly generate the organizational charts. As a vacant position is 
unoccupied, it cannot have a regular Emp ID or Manager ID number. 

VII. Appendices 

Appendix A: Troubleshooting 

1. Attach a Data Map 

a) Each worksheet requires its own data map, which provides 
instructions to Excel on how to export its data to XML. The instructions 
are contained in a special type of XML file called an XML Schema 
Document (XSD), which has an .xsd extension. This section provides 
instructions on how to reattach a XSD to the Excel file should the data 
map go missing. 

2. Open the Excel file. 

a) From the menu bar, select Data > XML > XML Source… 

b) The XML Source panel opens. Click the XML Maps… button located 
at the bottom of the panel. 

c) The XML Maps window opens. Click the Add… button. The Select 
XML Source window opens. 

d) Navigate to the local Dreamweaver OCIO site’s assets/data directory. 

(1) Select the appropriate XSD file:  

(a) Emp = ocio_org_chart_master_employees.xsd  

(b) CO = ocio_org_chart_master_contentowners.xsd  

(c) Desc = ocio_org_chart_master_desc.xsd  

(d) GI = ocio_org_chart_master_graphics.xsd.  

(e) Click the Open button to select the XSD. The new 
map will show in the XML Maps window.  

(f) Click the Rename… button to rename the map and 
give it the appropriate name as listed in Update Process, 
step 10. 
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e) Once attached, the map will show its fields in the XML Source panel. 
Each field has a corresponding column in the worksheet, in the same 
order. 

f) To export the data, the map fields must be mapped to the data 
columns. To map a field to a column, drag the field name to the 
respective column’s header and release the mouse once the cell 
highlights (a border will appear around the cell). Repeat for each field 
and column until all fields are mapped. 

B. Data Goes Missing After an Edit 

1. The Org Chart pages are controlled by the orgSub template 
(g2_c2_orgSub.dwt), which contains a number of specialized variables that 
allow the organizational acronyms to be passed to the Adobe Spry widgets, 
e.g. the tabbed panels. Spry is Adobe’s AJAX framework. Spry generates not 
only which graphic displays on a given page, but also what content shows 
within the tabbed panels on the page. 

2. On these pages, the only area that is directly editable from within the 
normal DW Design/Code view is the In this Section area. 

3. The Spry data tests rely on the correct entry of acronyms into not only a 
given Org Chart page, but also into the underlying spreadsheet. If someone or 
something (a person, a description, or a content owned document) goes 
missing after an update, check the data first. This is especially true if no 
reorganization of organizations has occurred. 

4. All Spry data tests rely on double-barreled field tests, i.e. the Spry code first 
checks the parent acronym and then the child acronym. If either does not 
match in a given row of the given data source (essentially a mini-database held 
in memory), then that row does not display. All acronyms must be uppercase. 
Additionally the parent organization must be the immediate parent 
organization, not the grandparent or great-grandparent organization. For 
example, in the CISG organization, the parent of the Monitoring Section (MS) is 
the Document Services Branch (DSB), not CISG, as its organizational path is 
CISG > PRD > DSB > MS. 

C. B. Appendix B: Tips and Tricks 

1. 1. Excel Oddities 

WARNING: Excel sometimes changes a column data type when copying information from 
another spreadsheet or other source. This causes a serious problem at export, not only to the 
XML, but also to OrgChart Pro. For example, it sometimes changes the ID numbers to text, 
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rather than keeping them as numbers. It also tries to hyperlink URLs. The numbers, i.e. 
integers must remain numbers, the URLs as text. 

D. Problem 1: Excel tries to ‘correct’ spaces within acronyms that have the spaces for 
Section 508 reasons, e.g. when entering the chart alt tag text on the GI worksheet, Excel 
tries to ‘correct’ the spaces within the organizational acronym.  

1. Solution: DO NOT allow Excel to do so. Click the Undo icon or [Ctrl] + Z. 

E. Problem: Excel converts a text URL to a hyperlink. 

1. Solution: Remove the hyperlink. Right-click on the URL and when the menu 
appears, select Remove Hyperlink. 

VIII. For Discussion 

A. Use of decision tree at beginning of document/procedure. 1. Any worksheet other than 
Emp. 2. Emp change only – NOT manager. 3. Manager or organization change where 
images need redraw. 4. Add/remove organizations that result in template changes. 
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